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Steady State Process Simulation Using ASPEN Plus™

* It is based on steady state governing equations like conservation of mass,
momentum and energy of various unit operations and unit processes.

* The governing equations results operating conditions of the process plant like,
flowrate, enthalpy (temperature), pressure, compositions of each streams,
amount of energy needed, overall yield, conversions etc.

« The steady state process simulation utilizes thermodynamic and transport
properties of various species, equilibrium data of vapor-liquid, gas-liquid, liquid-
liquid, solid-liquid, and chemical equilibrium data.

* It determines the size of equipment in a chemical plant.



Start

* Begin by opening Aspen Plus. A registration screen (connect to engine) comes up;
click OK. Click ‘maximize’ to fill the screen. This step may differ depending upon
installation.

* For a new problem, it is useful to choose a template that is similar to a problem;
Model Library

* Model library consists modules which are the replica of various units used in the
flow sheeting of a chemical process plant.

* It can be viewed clicking on the icons at the bottom of the Aspen Plus screen. If
the icons are not displayed, choose the View/Model Library from menu option.
When the unit is clicked the words shown at the bottom of the screen give a brief
description of the module.

Introduction to Chemical Engineering Computing, Bruce A Finlayson, JOHN WILEY & SONS, INC., PUBLICATION.
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Selected Major Blocks Available in Aspen Plus

* Mixers/splitters
a. Mixer — combine material
b. Fsplit — split specifications for output
c. Ssplit — splits using substreams

* Separators
a. Flash2 —rigorous vapor-liquid split or vapor—liquid—liquid split
b. Flash3 — rigorous vapor-liquid-liquid split
c. Decanter — separate two liquid phases
d. Sep — use split fractions
e. Sep2 — separation based on flows and purities

* Heat exchangers
a. Heater — heaters, coolers, condensers
b. HeatX — co- and counter-current heat exchangers
c. Hetran —shell and tube heat exchangers
d. Aerotran — air-cooled heat exchangers



e Columns

a. DSTWU - shortcut distillation using Winn—Underwood—Gilliland equations and
correlations

b. Distl — Edmister shortcut distillation

c. RadFrac —rigorous two phase and three phase, absorber, stripper, distillation
columns using stages

d. Extract — liquid—liquid extraction

* Reactors
a. RStoic — stoichiometric fractional conversion or extent of reaction
b. RYield — nonstoichiometric — based on yield distribution
c. REquil — rigorous equilibrium
d. RGibbs — rigorous equilibrium and/or multiphase Gibbs free energy minimization
e. RCSTR — continuous stirred-tank reactor, specify volume
f. RPlug — plug flow reactor, specify length and diameter of tube
g. RBatch — batch reactor, specify cycle times

The RCSTR, Rplug, and RBatch reactors require the choice of a reaction set and the
building up of a reaction rate expression



* Pressure changes
a. Pump
b. Compr — compressor

* User model



Aspen Plus Simulation
Vapor liquid equilibria in a flash chamber

Problem: For a mixture (100 mol) of propane, n-butane, n-pentene, and n-octane, phase
equilibrium K-values and inlet compositions {z} are given in the table below at 180 °F

and 70 psi. Estimate vapor {y;} and liquid {x;} phase compositions, vapor product V and
liguid product L in a flash chamber using Aspen Plus simulator.

Components, i {z;} Phase

Equilibrium K-

value
propane

n-pentene




 Start Aspen and choose Template; OK. When the window appears, choose General with
English Units. In the Run Type (lower right-hand corner), choose Flowsheet. Click OK
when the Aspen engine window appears. (This last step is specific to your installation.)

* Or

* Click Aspen Tech, select Aspen Plus 10.1-0, and click Aspen Plus User Interface. The Aspen
Plus Startup dialog box appears. You can use this dialog box to open an existing
simulation or to create a new simulation using a template or a blank simulation. Select
the Blank Simulation option and click OK to start the new Aspen Plus simulation.
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Aspen Plus displays the File menu:
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From the File menu select
Open.

The Open dialog box appears.
Your default working directory
is displayed in the Look In box.
You can navigate to the folder
containing a file by using the
Look In box or the Look In
Favorites button

Click the Look in Favorites
button.



A list of folders is displayed in the Open dialog box:

Open ___________________________ HE

Look in: | A Favorites :J | | I |§§5
BJ?Applicationsé [No preview available.
L;;l Assay Libranes
1] Data Package
] Electrolyte Inserts
L] Examples
File name: Open
Files of type:  |Aspen Plus Files [*.bkp, *.apw, * apl, *.inp) j Cancel

Double-click the
Examples folder.
From the files list,
select flash.bkp and
click Open.

Click Yes when
Aspen Plus prompts
"Do you want to
close current run
before opening new
run?"

Click No when
Aspen Plus prompts
"Save changes to
Simulation 1?"



* If the bottom of the screen does not show the units, use the View/Model Library pull-
down menu or press the F10 key. In the units at the bottom, choose Separations, then click

on Flash2. Click on the flow sheet, and the flash (phase separatlon) unit appears.
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Flowsheet for Flash2 unit

Picture from B. A. Finlayson

To add the input and output
streams, click on Material
Streams  (lower left-hand
corner), click on the flowsheet
and drag a stream to the red
arrow that is input to the flash
unit. Click on the red arrows
coming out and drag the
stream away.

If any red arrows show in the
flowsheet, it means that the
unit is not properly connected;
it will message (Bottom right
corner) in the status indicator
‘Flowsheet not Complete’.
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[For Help, press F1

[Ci\i ars\Aspen Properties 11,1 | (UM |

Required Input Incomplete

If the flowsheet s

complete, the status
indicator message
‘Required Input
incomplete’.

Click on Next button or
Data browser button
in the in the toolbar.

The data browser
dialogue  box  will
appear. This will bring a
menu to the left of the
screen.

The boxes that are red
indicate that you still

need to supply
information. Start at
the top and work

down, turning the red
boxes into blue boxes
by filling in the forms.



* Filling Component/Specifications in the data browser  Picture from B. A. Finlayson
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. Txpe the name or formula of the chemicals. If Aspen Plus does not recognize your
chemical, a window apﬁears that allows you to search again, and it will suggest a number
of possibilities. When the components are completely specified, you should have an entry
for every chemical in the column labeled Component name. The first column is what you
are naming the chemicals, but the third column is what Aspen Plus uses when it obtains
physical properties. If that column is blank, the program will not work.

Comporentname | Fomula
N-EUTANE {C4H10-1




* Filling Property/Specifications
* Choose the thermodynamic model

* Using Redlich—Kwong equation of state option in Aspen Plus  picture from B. A. Finlayson
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* Filling Property/Specifications

* Choose the thermodynamic model
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* Filling Streams

* Choose the input stream, click on it, and insert the temperature, pressure, and flow rates of

every chemical. _ _
Picture from B. A. Finlayson
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* Filling Block

* In the list at the left, choose Blocks, then B1 (or whatever you have named your Flash2
unit), then Input. Choose Specifications, and insert the temperature and pressure of the

unit. Picture from B. A. Finlayson
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Flash2 Results

Picture from B. A. Finlayson

Temperature, “F
Pressure, psi
Vapor fraction
Mole flow. 1b mol/h
Mass flow, Ib mol /h
Volume flow, cubic ft/h
Enthalpy, MMBtu/h
Mole flow, Ib mol /h
Propane
n-Butane
n-Pentane
n-Octane
Mole fraction
Propane
n-Butane
n-Pentane
n-Octane

180

70
0.418979
100
7355.297
3865.909

6. 707213

10
30
40
20

0.1
0.3
04
0.2

180

70

1
41.89795
2587.239
3735.26

—2.262202

7.880996
18.01565
15.09625

0.90505

0.1881
0.429989
0.36031
0.021601

180

70

0
58.10205
4768.058
130.6492

—4.505011

2.119004
11.98435
24.90375
19.09495

0.03647
0.206264
0.428621
0.328645

* Choose the next button at the top. If

the input is incomplete, a window
will appear to notify you and direct
you to the missing data. If the input
is complete, a window will appear
to notify you of that, too. Click on
the button to make it perform the

calculation. This will cause the
calculation of the process (here one
unit) to proceed. Once the

calculations finish (read the error
messages, if any), click the Results
box (lower one) to return to the
regular menu. Then look at
Results/Streams. The stream data
will appear in tabular form, as
shown in Table 3.3. If you click
Stream Table, it will also be
reproduced on your flowsheet.



Model the T-xy or p—xy diagram for the vapor-liquid of binary pairs using Property Analysis

* Step 1: Start Aspen and choose Template. A window appears; choose General with Metric
Units. From the Tools menu, select Analysis, then Property, then Binary. The Binary
Analysis dialog box appears

B simulation 1 - Azpen Plus 2004,1 - aspenONE
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|rnalysis type.
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The options for the fugacity coefficient of the gaseous phase are: ideal gas, Redlich—
Kwong or Redlich—-Kwong Soave, Peng—Robinson, plus a few specialized ones.

In the liquid phase, the simplest option is an ideal liquid, That choice leads to Raoult’s
law. Other models include, NRTL, Electrolyte NRTL, UNIFAC, UNIQUAC, Van Laar, and
Wilson.

Oil and Gas Production (OIL GAS) — Peng—Robinson with Boston—Mathias a function
(PR-BM) or Redlich—Kwong—Soave with Boston—Mathias a function (RKS-BM).

Refinery, medium pressure (Refinery) — Chao—Seader, Grayson, Peng—Robinson,
Redlich—Kwong—Soave.

Refinery, hydrogen-rich applications (Refinery) — Grayson, Peng—Robinson, Redlich—
Kwong—Soave.

Gas processing, hydrocarbon separations (GASPROC) — Peng—Robinson with Boston—
Mathias a function (PR-BM), Redlich—Kwong—Soave with Boston— Mathias a function
(RKS-BM), Peng—Robinson, Redlich—Kwong—Soave.

Gas Processing, acid gas absorption (Chemical and Electrol) — electrolyte NRTL.
Petrochemicals, aromatics and ether production (Petchem) — Wilson, NRTL, UNIQUAC.



* Chemicals, phenol plants (Chemical) — Wilson, NRTL, UNIQUAC.

* Chemicals, ammonia plant (Chemical) — Peng—Robinson, Redlich—Kwong—Soave, SR-Polar
(Schwartzentruber—Renon).

* Chemicals, inorganic chemicals (Chemical and Electrol) — electrolyte NRTL.

* Coal processing, combustion (Coalproc) — Peng—Robinson with Boston—Mathias a
function (PR-BM), Redlich—Kwong—Soave with Boston—Mathias a function (RKS-BM), or
the combustion databank.



MULTICOMPONENT DISTILLATION WITH RadFrac

* Problem: The feed is 100 Ib mol/h propane, 300 Ib mol/h i-butane, and the other
chemicals as listed in Table, at 138 psia and 75°F. The column operates at 138 psia with 26

stages, reflux ratio 3.44 and feed entrance on the 19 stage. The Refinery/Chao—Seader
property method is used.

Chemical Boiling Point (°C) at 1 atm

Propane 42.1

i-Butane 11.9

n-Butane 0.5 Picture from B. A. Finlayson
i-Pentane 27.9

n-Pentane 36.1

* On the Aspen Plus Startup dialog box, select the Template option. Click OK to continue.
The New dialog box appears.

» Select the General with English Units template for this session. The default Run Type,
Flowsheet, is appropriate for this session.

* Click OK to start the new Aspen Plus simulation.



— |_--- -

Picture from B. A. Finlayson




From the Aspen Plus main window, click the Columns tab on the Model Library.

Move the mouse over the RadFrac block and read the prompt. The prompt for RadFrac
suggests this is the right model for this problem.

Click RadFrac, then press the Help key (F1).

To choose a different icon for RadFrac, click the down arrow to the right of RadFrac in the
Model Library.

* Select the icon labeled FRACT1 under the RadFrac block.
===l |« Click the icon and drag it to the Process Flowsheet window.
ﬂ& * Click the Material Stream icon on the left side of the Model Library.

I
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Picture from B. A. Finlayson
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Ports that must have at least one stream connected are
shown in red. Optional ports are shown in blue. If you
position the mouse pointer over a port for a few seconds, the
arrow is highlighted and a description of the port appears.



To connect the feed streams

II|||II Aspen Plus - Simulation 1
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Graphical simulation flowsheet is now
complete. The status indicator in the
bottom right of the main window says
"Required Input Incomplete" indicating
that further input specifications are
required for the simulation.
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Entering Components

e Click the Next button on the Data Browser window toolbar. Data browser window
appears.

* In the first Component ID box, type PROPANE and press Enter.
* Click the next blank Component ID box, Type BUTANE and press Enter.

Selecting Thermodynamic Methods

* Use the Properties Specifications Global sheet to select the thermodynamic methods
used to calculate properties such as K-values, enthalpy, and density.

* In general, the UNIFAC property method for liquid phase nonideality is chosen.
 But for refinery product, Refinery/Chao—Seader property method is used.

Entering Stream Data

* Enter the following state variable and component flow specifications for the feed stream

* feed is 100 Ib mol/h propane, 300 Ib mol/h i-butane, 500 Ib mol/h n-butane, 400 Ib
mol/h i-pentane, 500 Ib mol/h n-pentane.

* P=138 psia and T= 75°F



Entering Unit Operation Block Data
* Click the Next button on the Data Browser window title bar.

 The Aspen Plus expert system displays a Completion Status window, stating that you
need to enter Number of stages, Condenser type, specifications, in order to complete
this sheet:

 Configuration | = Streams | = Pressure | o Condenser | Feboile AP hase
q

_ * Now enter the operating
e specifications  for  the
Mumber of stages: &2
Condenser: Tatal _:] column:
B ebailer Fetlle <] » 26 stages, Set the reflux
Valid phazes: W apor-Liguid ;I I'atiO to 3-44 an d enter the
Convergence: Standard _ﬂ feed on the thirteenth
— Operating zpecifications Stage'
Distillate rate w||Male  =]{200 Ibmalhr ]
R efls ratio =|[mole =][2 ;! Picture from B. A. Finlayson
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Running the Simulation

e Click the Next button on the Data Browser window toolbar.

* Click OK on the Required Input Complete dialog box.

3 |
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&) Hocks have been sxscyled

The Control Panel allows you to
monitor and interact with the
Aspen Plus simulation calculations.
The simulation calculations occur in
three sequential steps:
1) Processing input specifications
2) Calculations begin
3) Generating results

! Picture from B. A. Finlayson
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Examining Block Results

e Click The individua Block n the simulation flowsheet.

e Select Results from the menu.

Picture from B. A. Finlayson

* Click the Profiles form in the menu tree on the left side of the Data Browser window.

Mole flow 1b mol /h
Propane
i-Butane
n-Butane
i-Pentane
n-Pentane
Mole fraction
Propane
i-Butane
n-Butane
i-Pentane
n-Pentane
Total flow, Ib mol /h
Total flow, 1b/h
Total flow, cubic ft/h
Temperature, “F
Pressure, psi
Vapor fraction
Liquid fraction

100
300
500
400
500

(1.055556
(). 166667
0277778

0.222222

0.277778
1800
115843.6
3126.01
75

138

0

1

85.80379
12.31199
1.883926
0.000257
4.61 x 10

0.858038
0.12312
0.018839
2.57 x 10°°
461 x 1077
100
4608.785
147 3943
80

138

0

|

14.19621
287.688
498.1161
399.9997
500

0.008351
0.169228
0.293009
(.235294
0.294118
1700
111234.8
3489477
199.5242
138

0

1

TABLE.

Multicomponent Distillation with
RadFrac, Reflux Ratio=3.44

86% of the propane goes out
in the top stream; along with
4% of the i-butane. The
condenser is at 80°F and has a
heat duty of —2.94 x10° Btu/h,
and the reboiler is at 199.5°F
and has a heat duty of 11.5
x10° Btu/h. Above the feed,
the flow rate varies between
283 and 344 Ib mol/h, and
below it, the flow rate varies
between 2998 and 3097 Ib
mol/h.

Stream data for



Calculation with higher reflux ratio

* For reflux ratio 5, 94.2 Ib mol/h of propane goes out in the top stream. Increasing the
reflux ratio to 7.5 gives 98.2 Ib mol/h of propane, and a reflux ratio of 10 gives 99.2 Ib
mol/h of propane. Picture from B. A. Finlayson

Fig. Condenser and reboiler calculations for Multicomponent distillation with RadFrac, reflux ratio = 3.44.



Reactors

e Chemical reactions occur under diverse conditions in many different types of equipment.

* RStoic, RYield, RGibbs, and RCSTR can have any number of material feed streams, which
are mixed internally. Heats of reaction are not required for any reactor model. Aspen
Plus calculates heats of reaction using heats of formation.

* For RCSTR, RPlug, and Rbatch utilize reaction kinetics information using:
1. The built-in power law model.
2. The built-in generalized Langmuir-Hinschelwood-Hougen-Watson (LHHW) model.
3. A user-written Fortran subroutine.
* Rstoic
1. Reaction kinetics are unknown or unimportant.
2. Extent of reaction or conversion can be specified.
3. Rstoic can handle reactions that occur independently in a series of reactors.
4. It can also perform product selectivity and heat of reaction calculations.



* RYield

RYield models a reactor by specifying reaction yields of each component. This model is
useful when:

1. Reaction stoichiometry and kinetics are unknown.
2. Yield distribution data or correlations are available.
* REquil

REquil models reactors when some or all reactions reach equilibrium. REquil can
calculate single-phase chemical equilibrium, or simultaneous phase and chemical

equilibria. REquil calculates equilibrium by solving stoichiometric chemical and phase
equilibrium equations.

* Rgibbs
1. RGibbs models single-phase chemical equilibrium, or simultaneous phase and
chemical equilibria.
2. reactor temperature and pressure, or pressure and enthalpy are specified.

3. RGibbs minimizes Gibbs free energy, subject to atom balance constraints. This
model does not require reaction stoichiometry.



o

RCSTR

B W N

Rgibbs can determine phase equilibrium without chemical reaction, particularly for
multiple liquid phases.

Assign components to be in particular phases in equilibrium.

Use different property models for each liquid or solid solution phase.
Chemical equilibria can be restricted by specifying

|. Fixed moles of any product

Il. Percentage of a feed component that does not react

lll. Fixed extents of reaction

IV. Temperature approach to equilibrium for the entire system

V. Temperature approaches for individual reactions

Reaction kinetics are known.
The contents of the reactor have the same properties as the outlet stream.
RCSTR can model equilibrium reactions simultaneously with rate-based reactions.

RCSTR computes heat duty given the temperature or temperature given the heat
duty.



* RPlug
1. RPlug rigorously models plug flow reactors.
2. A cooling stream around the reactor is optional.
3. RPlug model reactors with cocurrent and countercurrent coolant streams.
4. RPlug handles rate-based kinetic reactions only.

e Rbatch
1. RBatch rigorously models batch or semi-batch reactors.

2. For semi-batch reactors, a continuous vent and any number of continuous or
delayed feeds can be specified.

3. RBatch handles rate-based kinetic reactions only.



Ammonia Process

* The feed to the process is nitrogen, hydrogen, and a small amount of carbon dioxide
(left over from the process to make the hydrogen).

* Input stream to the process (at 80°F and 300 psia): nitrogen, 100 Ib mol/h; hydrogen,
300 Ib mol/h; ammonia, 0; and carbon dioxide 1 Ibmol/h. The inlet stream is
compressed to 4000 psi with an isentropic compressor

* The process feed is mixed with a recycle stream and heated to 900°F, the reactor
temperature, and sent to the reactor. The feed to the reactor is roughly a 3:1 mixture
of hydrogen and nitrogen, with some ammonia, too.

* In the reactor, there is a pressure drop of 30 psi.

* The outlet is cooled to 80°F and the liquid and vapor phases are separated.
* The vapor phase goes to recycle, and 0.01 percent of it is used as purge.

* A recycle compressor then compresses the rest from 3970 to 4000 psia.

* A small part of the recycle stream is bled off as a purge stream to prevent the buildup
of impurities.
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Picture from B. A. Finlayson
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ASPEN Flow Sheet of Ammonia Process




The identification of components

* It is useful to check the connections between the units using the Flowsheet
Opthn/ SECtIOn/ / GLOBAL Picture from B. A. Finlayson
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» After selecting Flowsheet option/Section//GLOBAL, the data browser screen is

shown in the following figure:
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Flowsheet in brief

Any disconnected stream
will not show its numbers
that is shown by input
stream ID and Port.



The operating parameters for the compressors
* An isentropic compressor (B1) in the feed stream to compress feed gases.

» Discharge pressure 4000 psi. Picture from B. A. Finlayson
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* An isentropic compressor (B9) in the recycle stream to compress recycle gases.
* Discharge pressure 4000 psi.

Picture from B. A. Finlayson

B Block B9 (Compr) Setup - Data Browser

o3l
o
53
o
s34
7
=&
%...



The operating parameters for the heaters

* A heater (B3) in the reactor inlet to heat the reactor feed to 900 °F, and at a pressure of
4000 psi.

Picture from B. A. Finlayson
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* A cooler (B5) in the reactor outlet to cool the reactor product to 80 °F, and at a pressure
of 3970 psi.

Picture from B. A. Finlayson
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The operating parameters for the reactor

* A Gibbs reactor (B4, RGibbs) operated at a pressure of 3970 psi and at a temperature of
900 °F.

Picture from B. A. Finlayson
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Picture from B. A. Finlayson
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The specifications for the mixer (B2) Picture from B. A. Finlayson
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* The specifications for the separator/flash chamber (B6, flash2)

Picture from B. A. Finlayson
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Specifications for the simple splitter (B8, FSplit)

Picture from B. A. Finlayson
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* In Aspen Plus streams and units different operating conditions like, T, P etc can be
specified.

Aspen Plus convergence
I Convergence Cony Options I,nzr?:nult.'; c-a Browser
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Sequential module for iteration
e Unit B1 is calculated only once, since the exact input to that unit is known.
e Then units B2—B9 are calculated.

* Since B9 is the last unit, Aspen Plus compares the output from unit B9 on this iteration to
the output from unit B9 one iteration before. If they are the same, convergence has been
achieved.

* |If not, it iterates more.



" ey A — ' * This simulation used the
1 B B | e "QH i | Wegstein method of

Sequerlia Mocule %] | = accelerating convergence.

* The solutions have not fully
converged after 30

iterations; the mass
balance error is in block B9
(the recycle compressor);
discrepancy as 0.5805 vs
0.5801, for a relative
difference of 0.07 percent.

TBREREIBA

n@saém

e The small difference is
acceptable.

* The Broyden method does
not converge much better.

* Direct method of iteration
did converge

It calculates all the
equations simultaneously
around the loop over and
over again.

Picture from B. A. Finlayson




Mass balance for ammonia process

Molar flow, [b mol/h 1 2 3 4 5 (3] ¥ B o 10 14
Na LEERLL LEIRL Y 135.25 13525 36,49 1.24 33,45 Jode 3525 33,25 0.00
H 300,00 300,00 1769.93 178998 1493.70 362 1490.08 1493.70 1458993 145995 0.15
M 0.00 0.00 3921 39.21 236,73 197.51 59.21 25673 5921 39.21 0.01
COa 1.00 1.00 291 291 291 .00 1.91 291 1.91 1.91 0.00

Total flow, 4001.00 401.00 1947.34 1987.34 178963 203.38 158643 176983 1586.29 1386.34 0.16
Ih ol h

Total flow, 3450.12 345012 B533.52 B533.52 B533.52 3449.73 5083.80 B533.52 5083.29 5083.40 0.51
Ib/h

Total fow, 774120 1452.90 3761.47 724942 6578235 95.66 231431 2409497 231408 230365 0.23
culbic ft'h

Picture from B. A. Finlayson

* Discrepancy between streams 9 and 10; hydrogen flow rate is off by 0.05 Ib mol/h,

compared with a total flow of 1490 |b mol/h.
(135.25-36.49)100

135.25
* Most of the carbon dioxide 1 Ib mol/h goes out in the product ammonia stream and

remaining 1.91 Ib mol/h in the recycle stream; the purge stream was no carbon dioxide
SO it is not necessary.

* Conversion is = 73%of N, which is a limiting reactant.



Energy balance for ammonia process

Temperature, °F
Pressure, psi
Vapor fraction
Liguid fraction
Solid fraction
Enthalpay,

B,/ ol
Enthal py,

Biu,/Th
Enthal p,

Btu/h
Entropy,

Bru/1b mol-R
Entropy,

Bru/1b-R
Density,

b mol fcubic ft
Density,

1b/cubic ft
Averape MW
Liquid volume 60°F,

cubic ft/h

B0.00
300

l

0

0
401,19
—46.63
= 160878
=4 8010
=0,5560
00518
04457

B.60358
344,02

890,83
4000

1

0

0
5301.56
616,19
2125927
—3.5080
=0.4077
0.2760
23746

5.6038
34402

245,82

8034

685562

=9 1477

=2.1304

0.5283

226087

42939
1704.97

900.00
4000

1

0

0
5009.06
1166.54
9954720
—4.4755
—1.0423
0.2741
L1771

4.2939
1704.97

R EEREH
3970

1

0

0
303818
637,23
5437816
—6.5801
= 1.3801
02721
1.2972

47678
15335.52

B0.00
3970
0

|
0
—28222.34
—1663.82
= 5739722
—42.8532
—2.5264
2.1261

360634

16.9624
17445

Picture from B. A. Finlayson

LAREE
3970

l

0

0
=4919.19
—286.84
= 1458248
—=11.4165
=3.5616
0.6833
2.1967

3.2045
1361.04

B0.00
3970

0. 8864
0.1136

0

=402 1.60
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0

0
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06853
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1360.90
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= 440365

=11.4105
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0.6886

22067

32045
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Feed compressor variables, unit B1. Picture from B. A. Finlayson

* The compressor is
very large ~ 900 HP
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Recycle compressor variables, unit B9. picture from B. A. Finlayson
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Heat exchanger (upstream to the reactor) variables, unit B3.
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Heat exchanger (downstream to the reactor)variables, unit B5.
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Mass balance for ammonia process (repeated figure)

Molar flow, [b mol/h 1

Ma 100,00
ki 300,00
NH, 0.00
O 100

Total flow, 401,00
Ih ol h

Total flow, 3450.12
Ib/h

Total flow, T741.20
culbic ft'h

2

100, (M
300.00
0.00
100
401.00

345012

145290

3
135.25
17589.98
5921
291
1957.34

B533.52

3761.47

4
135.25
1769.98
5921
291
1987.34

B333.52

724942

5

36,49
1493.70
236,73
291
178963

B333.52

657823

e Equilibrium persists in the reactor effluent.

* From the thermodynamic of chemical equilibria, K-values can be calculated from the

mole fraction of the scream 5.
* yn, = 0.0204; yy, = 0.8346; yyy, = 0.1434; K = 0.00488
* |tis close to the value of 0.00473 measured by Stephenson (1966).

* The reactor utilizes the NRTL thermodynamic model for chemical reaction equilibrium.

L

1.24
3.62
197.51
1.00
203,38

3449.73

95.60

7 B

33235 649 3325
1490.08 1493.70

54921 256.73 3921
1.91 291
1386.45 1769.53
S0E3.80 8333.52
231431 240997
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Testing vapor-liquid equilibria in streams 6 and 7

* Solubility of nitrogen is 27.6 cm?/g ammonia when the pressure is 270
atm(~4000 psia) and at 25°C (~80 °F). It corresponds 0.021 mole fraction of
nitrogen in the liquid phase that is interpolated from values measured by
Stephen and Stephen.

* Using the values for stream 6 from the mass balance table gives a mole
fraction of 0.0061 that is smaller than literature but there is carbon dioxide
(ternary equilibrium) in the stream 6.

Reference:

 ASPEN PLUS, 1988, "ASPEN PLUS User Guide", Aspen Technology, Inc., Cambridge,
Massachusetts.

* Introduction to Chemical Engineering Computing, Bruce A Finlayson, JOHN WILEY
& SONS, INC., PUBLICATION.



